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Chemistry 111 Laboratory 
Experiment 1:  An “Atomic” Introduction to Conducting Calculations with Excel 

(This experiment will be conducted in OR341) 
 
Introduction 
A number of experiments in Chemistry 111/112 require calculations and graphing of 
experimental data.  Since the application of Microsoft Excel® provides a convenient and 
powerful way to display and manipulate data, we will require that Excel be used as a laboratory 
tool throughout this course.  The goal of this experiment is to help you obtain a necessary level 
of proficiency with the Excel skills that you will need to employ in this laboratory manual.  We 
recognize that each of you brings different Excel experience to this experiment.  Some students 
will have already used Excel extensively, while others may have never used the program.  
Although this experiment assumes no previous knowledge of Excel, we hope that everyone will 
benefit from completing these exercises. 
 
General Comments 
1.  Due to the number of computers in OR341, not everyone will be able to work independently 
on this activity.  If you work with a partner, try to share the work equally.  If one group member 
has less previous experience with Excel, it would be advantageous for that person to spend more 
time at the keyboard. 
 
2.  Although it is possible to complete these calculations with a pocket calculator, please resist 
this temptation!  A goal of this experiment is that you become sufficiently comfortable with 
Excel to use for many Chemistry 111/112 laboratory calculations, even those that could be 
accomplished with a calculator.  You will find that Excel, if used properly, is much more 
powerful than a pocket calculator. 
 
3.  The goal of this experiment is for you to master Excel skills, not to finish quickly.  Therefore, 
please take your time and ask for help from your lab instructor or assistant as needed.  The time 
that you invest today will pay dividends later when you prepare laboratory reports for Chemistry 
111/112. 
 
Creating a Spreadsheet:  Chromium Isotopes 
 

• Open Microsoft Excel®. 
   
• Select “Excel Workbook” and then “OK” in the Project Gallery.   

 
The “Excel Workbook” may be already selected as the default.  A set of rectangular cells (a 
“Sheet”) should appear.  Each cell provides a potential location for text, numbers, or a set of 
mathematical instructions.  Each cell is “addressed” with a letter and number combination.  The 
vertical columns are labeled with letters and the horizontal rows with numbers.  In this way, the 
fourth cell in the fifth column is labeled E4 while the second cell in the third row is labeled B3. 
 
Let’s work with some data of chemical significance!  In the periodic table (next page), the square 
for Cr features two numbers:  24, the atomic number, and 51.996, the atomic mass.  Where do 
these numbers come from?  To answer these questions, we must consider the different naturally 
occurring isotopes of chromium.  The following table provides the number of subatomic particles 
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in the nuclei of the four common isotopes of chromium.  The atomic number definition is based 
on the number of protons in the nucleus. 
 

Isotope Protons Neutrons Electrons % Abundance 
Cr-50 24 26 24 4.35 
Cr-52 24 28 24 83.79 
Cr-53 24 29 24 9.50 
Cr-54 24 30 24 2.36 

 
We begin our set of examples by creating a spreadsheet (including headings) for these data. 
 

The Periodic Table 
1 

H 
1.0079 

                2 
He 

4.0026
3 
Li 

6.941 

4 
Be 

9.0122 

          5 
B 

10.81 

6 
C 

12.011 

7 
N 

14.007 

8 
O 

15.999

9 
F 

18.998

10 
Ne 

20.179
11 
Na 

22.990 

12 
Mg 

24.305 

          13 
Al 

26.982

14 
Si 

28.086 

15 
P 

30.974 

16 
S 

32.06 

17 
Cl 

35.453

18 
Ar 

39.948
19 

K 
39.098 

20 
Ca 

40.08 

21 
Sc 

44.956 

22 
Ti 

47.88 

23 
V 

50.942 

24 
Cr 

51.996 

25 
Mn

54.938

26 
Fe 

55.847

27 
Co 

58.933

28 
Ni 

58.69 

29 
Cu 

63.546

30 
Zn 

65.38 

31 
Ga 
69.72 

32 
Ge 
72.59 

33 
As 

74.922 

34 
Se 

78.96 

35 
Br 

79.904

36 
Kr 

83.80 
37 
Rb 

85.468 

38 
Sr 

87.62 

39 
Y 

88.906 

40 
Zr 

91.22 

41 
Nb 

92.906 

42 
Mo 
95.94 

43 
Tc 
(98) 

44 
Ru 

101.07

45 
Rh 

102.91

46 
Pd 

106.42

47 
Ag 

107.87

48 
Cd 

112.41

49 
In 

114.82

50 
Sn 

118.69 

51 
Sb 

121.75 

52 
Te 

127.60

53 
I 

126.90

54 
Xe 

131.29
55 
Cs 

132.91 

56 
Ba 

137.33 

57 
*La 
138.91 

72 
Hf 

178.49 

73 
Ta 

180.95 

74 
W 

183.85 

75 
Re 

186.21

76 
Os 

190.2 

77 
Ir 

192.22

78 
Pt 

195.08

79 
Au 

196.97

80 
Hg 

200.59

81 
Tl 

204.38

82 
Pb 

207.2 

83 
Bi 

208.98 

84 
Po 
(209) 

85 
At 

(210) 

86 
Rn 
(222) 

87 
Fr 

(223) 

88 
Ra 

226.03 

89 
†Ac 
227.03 

               

                  
  * 58 

Ce 
140.12 

59 
Pr 

140.91 

60 
Nd 

144.24 

61 
Pm
(145) 

62 
Sm

150.36

63 
Eu 

151.96

64 
Gd 

157.25

65 
Tb 

158.93

66 
Dy 

162.50

67 
Ho 

164.93

68 
Er 

167.26 

69 
Tm 

168.93 

70 
Yb 

173.04

71 
Lu 

174.97

 

  † 90 
Th 

232.04 

91 
Pa 

231.04 

92 
U 

238.03 

93 
Np 

237.05

94 
Pu 
(244) 

95 
Am
(243) 

96 
Cm
(247) 

97 
Bk 
(247) 

98 
Cf 

(251) 

99 
Es 

(252) 

100 
Fm 
(257) 

101 
Md 
(258) 

102 
No 
(259) 

103 
Lr 

(260) 

 

 
Entering and Formatting Text 

• Type in the headings (one per cell) into the top row (row 1) of your spreadsheet.  
Start with cell A1. 

 
A spreadsheet can be much easier to navigate if data headings are highlighted.  It is common to 
highlight these headings with a distinctive font, bold type, or by underlining them. 

   
• After typing the five headings, select all five simultaneously by clicking and 

dragging across the five cells with the headings.  This will highlight the cells for 
collective formatting.   

 
• In the format menu, select “Cells”. 
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• In the “Format Cells” window, there are a variety of options.   
 

• Select the “Font” tab.  Change the Font to Times New Roman, the Font Style to 
Bold, and the Underline to Single.   

 
• Select the “Alignment” tab and choose “Center” from the list below “Text 

Alignment, Horizontal”.  Click “OK” when your formatting is complete. 
 
Entering and Formatting Data 
 

• Enter the data for the chromium isotopes.   
 
The number of protons in an atom’s nucleus defines its identity.  However, the number of 
neutrons in the chromium nucleus can vary.  The table indicates the natural abundances for the 
four chromium isotopes.  Approximately 84% of chromium atoms on Earth feature 28 
neutrons/nucleus. 
 
Let’s change the font and center the data in the cells for practice.   
 

• Simultaneously highlight the four rows of cells with data by clicking and 
dragging. 

 
• Select “Cells” under the format menu.   

 
• In the “Format Cells” window, change the Font to Times New Roman.  

 
• Select the “Alignment” tab and choose “Center” from the list below “Text 

Alignment, Horizontal”.   
 

• Click “OK” when your formatting is complete. 
  
It is likely that Excel will display the % Abundance of Cr-53 as “9.5” instead of “9.50”.  Since 
the number of significant figures is critical when communicating scientific data, we need to 
know how to rectify this situation.   
 

• Select and highlight all the Abundance data.   
 
• Select “Cells” under the format menu and then the “number” tab.   

 
• Choose “number” from the list and make sure that the number of decimal places 

is 2.  Click “OK” and “9.50” should now be displayed. 
A common term associated with atoms is the “mass number”.  The mass number is the sum of 
protons and neutrons in each nucleus.  Let’s use Excel to calculate the mass number for each of 
the four naturally occurring chromium isotopes.  Excel provides a way to set up each calculation 
once rather than having to deal with each one separately (as you would need to do with a 
calculator).  The ability to perform multiple calculations conveniently is one of the most useful 
features of Excel.  A convenient place to list the mass numbers is in between the electrons and 
the % abundance columns.  Let’s insert a column between these two table entries! 
 



Experiment 1 

 4

Inserting a Column 
• Select the cell containing the word “Electrons”.   
• In the “Insert” menu, select “Columns”.  A new column should appear between 

the original “Electrons” and “Neutrons” columns.   
• Label this column “Mass Number” and format this heading like the others.  There 

is an easy way to do this, since we have already generated other headings and 
formatted them as we would like them to appear.  On the second row of the menu 
at the top of the screen, there’s a small paintbrush with blue paint on it, called the 
“format painter.”  To quickly copy the formatting of the “Neutrons” heading to 
the “Mass Number” heading, 

⋅ Click on the “Neutrons” heading 
⋅ Click the format painter paintbrush icon 
⋅ Click on the “Mass Number” heading with the “+” sign of your cursor 

 
Calculations 

• Select the cell in your new column to the immediate right of the ‘26’ neutron 
count (D2).  The mass number for Cr-50 is the sum of the number of protons (in 
cell B2) plus the number of neutrons (in cell C2). 

   
• To conduct this calculation type: 

 
= B2 + C2, and then return  

 
Alternatively, clicking on the cells at the appropriate time while writing this command can enter 
these cell locations. 

 
The mass number 50 should appear in cell D2.  The mass number is the key quantity to specify 
the isotope under consideration.  In this table, the mass number is incorporated into the name of 
the isotope.  Note that the ‘=’ communicates to Excel that the cell contains mathematical 
instructions.  A variety of standard mathematical functions can be accomplished in this fashion.  
The standard symbols include the expected + (addition), - (subtraction), * (multiplication), and / 
(division).  To represent a power in scientific notation, use the letter e to represent 10 to a power.  
For example, 6.02e23 is interpreted by Excel as 6.02 * 1023. 
  
What about the other mass numbers for our new column?  You could repeat this process for each 
isotope but this isn’t necessary!   
 

• Select the cell with the first mass number.   
 
After you have selected this cell there should be a small square box in the lower right hand 
corner of this cell.   
 

• Select this box with the cursor and “drag” down (while holding the mouse button) 
through the three cells below.  When you release the mouse button, you should 
see the other mass numbers appear!   

 
Excel automatically conducts the same calculation but inputs the analogous data from the rows 
below.  This Excel application is extremely useful since it drastically increases one’s efficiency 
when using large quantities of data. 
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Another important calculation is to calculate the mass of a single atom of each isotope.  As you 
might expect, an excellent approximation for the atomic mass should be the sum of the masses of 
the component subatomic particles.  The atomic mass unit (amu) is typically associated with 
masses of this magnitude.  1 amu = 1.66054 * 10-24 g. 

 
Our goal is to calculate the approximate atomic masses of each isotope efficiently without 
entering the necessary conversion factors four times.   
 

• To this end, type “Proton =” in A7, “1.00727” in B7, and “amu” in C7. 
   
• Enter the following data using the same format in row 8 (A8,B8,C8):   

Neutron = 1.00866 amu 
 

• Enter the following data using the same format in row 9 (A9,B9,C9): 
Electron = 5.4858e-4 amu 

 
Excel probably won’t display the mass of the electron to the desired number of significant digits.   
 

• Highlight this cell and select “Cells” from the “Format” menu. 
   
• Choose the “number” tab and adjust the number of decimal places until the value 

in the sample window has the correct number of significant digits.   
 

• If necessary, select the “Font” tab and change the font of the electron mass so it 
matches the other numbers and text.  Center your masses in the cells as described 
previously. 

 
• Begin a new heading “Mass of Component Particles (amu)” in A14 and format 

this heading with Times New Roman, bold, and single underline.  Don’t center 
the text in the cell since the heading is wider than column A.   

 
Now we are ready to setup the calculation.   
 

• Type the following in cell A15 and then hit return: 
 

= B2*$B$7 + C2*$B$8 + E2*$B$9    
 

The mass of 24 protons + 26 neutrons + 24 electrons should appear in A15.  The $ characters in 
the formula indicate that we plan to use these values as constants for additional calculations.   
 

• Select A15 and “drag” down the square at the lower right to complete the 
calculations for the other three isotopes.  Very nifty!   

 
If the constants weren’t indicated via the $ characters, Excel would have used data in B8, B9, 
and B10 to calculate the mass in cell A16.  The $ characters “lock in” the constants so that the 
same cell is referred to in each calculation.  The process of adding the $ characters establishes an 
“absolute cell reference”.   
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• Format the newly calculated masses to match the other data (i.e., font, centered in 
cell). 

   
• Format the numbers so that the value in A15 is displayed as 50.41. 

 
The numbers in this column are close to the 51.996 in the periodic table for chromium but none 
of the numbers match this value exactly.  The atomic mass in the periodic table is the average of 
the masses of the naturally occurring isotopes weighted according to their abundances.  Let’s 
conduct this calculation using Excel! 

 
• Enter “Average Component Mass =” in B11 and format the text (Times New 

Roman and at the right edge of the cell). 
   
• Enter “amu” in D11 and format this text.   

 
To conduct this calculation, we need to divide each % abundance by 100 and then multiply the 
resulting value by the masses of the component subatomic particles.   
 

• The following statement in C11 will do the trick: 
 

  =(F2/100)*A15+(F3/100)*A16+(F4/100)*A17+(F5/100)*A18 and then enter. 
  

• Format the number to match the other masses in A15-A18  (font, significant 
digits, etc.). 

 
Why is this value larger than the average atomic mass reported for chromium in the Periodic 
Table?  Are the abundances incorrect?  Would you believe that an atom of Cr-52 actually 
possesses a smaller mass than 52.43 amu?  It actually has a mass of 51.94 amu!  How is it 
possible that an atom’s mass doesn’t match that of its component subatomic particles?  It turns 
out that another fascinating factor is at work here that we haven’t yet considered.  When atoms 
are created from subatomic particles (in stars), a portion of the masses of the subatomic particles 
is converted to energy.  The energy equivalent of this lost mass (called the “mass defect”) can be 
calculated using Einstein’s famous equation E = mc2 (where c is the speed of light).  Although 
we won’t conduct this calculation today, we can attribute the high average molar mass when only 
using the masses of the individual subatomic particles to this phenomenon. 
 
Let’s enter the known masses of each isotope.   
 

• Enter “Atomic Mass (amu)’ in D14 and “Mass Discrepancy (amu)” in F14.  
Format the text like that in A14.   

 
• Enter the actual masses for Cr-50 (49.95), Cr-52 (51.94), Cr-53 (52.94), Cr-54 

(53.94) below the Atomic Mass heading.  These masses take into account this 
mass defect phenomenon.  Below the Mass Discrepancy heading, enter formulas 
that calculate the difference between the mass of the component particles and the 
actual atomic mass.  (Subtract the smaller value from the larger value.) 

 
• Format the numbers appropriately. 
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• Calculate the weight average of the actual atomic masses in C12.  Use the 
weighted average approach described above.   

 
• This cell should be entitled “Average Atomic Mass =” (in B12) and formatted as 

the heading above, in B11. 
 

• Type “amu”  (in D12).   
 

• Both cells should be formatted for Times New Roman font.   
 

• Format the number to match that of the other masses.   
 
At last, your mass should match that for chromium in the Periodic Table!  Keep in mind that no 
chromium atoms with 52.00 amu mass exist - this is only an average value based on the 
abundances of the naturally occurring isotopes. 

 
The Function Wizard 
In addition to the mathematical operations that can be performed within cells, Excel has the 
capability to perform a wide range of calculations using the “Function Wizard”.  This application 
can be found by selecting the button labeled fx near the top of the screen.  Let’s use our data to 
practice using the Function Wizard, even if the numbers obtained aren’t useful for chemical 
interpretation. 

 
Let’s calculate the sum of the abundances for our four isotopes in F8.   
 

• Enter “Total % Abundance =” in E8 (change to Times New Roman font and align 
on the right edge of the cell) and then select cell F8. 

   
• Select the Function Wizard.  A window entitled “Paste Function” should appear.   

 
• Select “Math & Trig” from the “Function category” list.   

 
• Select “SUM” from the list of abbreviations under Function name.   
• Select “OK”.   

 
• Type F2:F5 adjacent to “Number 1” in the “SUM” box and click “OK”.   

 
The colon in “F2:F5” represents all the numbers in the column from the number in cell F2 
through the number in the cell F5. 

 
Excel provides multiple ways to enter data into a function.  To illustrate another method, let’s 
calculate the average of the mass discrepancies in F9.   
 

• First type “Average Mass Discrepancy =” in E9 (format as E8) and then select 
cell F9. 

 
• Select the Function Wizard and choose “AVERAGE” from the “Statistical” 

function list.   
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• Use the mouse to move the “average” box down to reveal the spreadsheet data.   
 

• The four mass discrepancy values can now be alternatively selected with the 
mouse by clicking on F15 and dragging to F18.  Release the mouse button and 
select “OK”.   

 
The (non-weighted) average of the mass discrepancies for the four isotopes should appear in F9.   
 

• Format the average to possess the appropriate number of significant digits. 
 

Alternately, a function can be employed by either of the following procedures: 
 

1. Select the cell where the desired function is to be used.  If you wanted to 
calculate a sum, you could simply type “=SUM(F2:F5)” and then press enter. 

2. Another option would be to type “=SUM(“, then drag over the cells you want 
summed and hit enter. 

 
• Format your newly added text and numbers so that their font, etc. match the rest 

of the data in your spreadsheet. 
 
The Chart Wizard 
Most of the Chemistry 111/112 experiments that require application of Excel involve the 
generation of graphs.  Let’s practice using the Chart Wizard to make a bar graph with our 
chromium isotope % abundance data.  Excel calls a bar graph with vertical bars a “column 
graph.” 

 
To create a graph with the Chart Wizard: 

 
• Select the data you want to graph.  Select the % abundances in cells F2 through 

F5. 
 
• Click on the Chart Wizard icon.  This tiny icon features a magic wand over a 

column graph and is located to the right of the Function Wizard icon. 
 

• The long list of possible graph types is listed under “Standard Types”.  Select 
“Column” and the Chart sub-type shown in the upper left hand corner. 

 
• If you want to preview the general appearance of your graph, click on “Press and 

Hold to View Sample”. 
 

• Select “Next >” twice.   
 

• In the “Chart Wizard – Step 3 of 4 – Chart Options” window add titles to your 
graph.   

 
• Select the “Titles” tab and then: 

o Label the graph “% Abundances of Chromium Isotopes” in the Chart Title 
window. 

o Label the x-axis “Chromium Isotopes”. 
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o Label the y-axis “Percent Abundance” 
 

• Select the “Legend” tab and deselect “Show Legend”. 
   
• Click on “Next” and then “Finish”.  Your graph should appear.   

 
• Move the graph to the left side of the sheet and slightly below the data.  To resize 

the graph (if desired), use the mouse (click and drag) at the lower right corner of 
the graph. 

 
• Use Print Preview to make sure that all of your work fits on one page. 

 
• Print your entire spreadsheet to include with your report.  Please note that only the 

chart will print if the chart is selected. 
 
Because we are going to add to the work we have done so far, we will want to label what we 
have done on this “sheet” of the “workbook” (the collection of “sheets” in our spreadsheet 
program) before we proceed. 

• At the bottom of the screen you will see three “tabs,” labeled “Sheet 1,” “Sheet 
2,” and “Sheet 3.”  If you double-click on “Sheet 1,” you will be able the name of 
the top sheet.  Change the name to “Chromium Isotopes.” 

 
• You’ve already done a lot of work and you don’t want to lose it!  So, choose 

“Save” from the “File” menu.  Be sure to save to your network account, so you 
don’t lose your work when the system is rebooted!  You might even want to make 
a folder called “Chem 111” in there, to help keep things organized.  (Or not!) 

 
• Click on the tab labeled “Sheet 2” to bring up a blank sheet, which we will use in 

the next part of this experiment. 
 
Another “Atomic” Spreadsheet:  The Atomic Spectrum of Hydrogen 
An important goal of Chemistry 111 is to learn about the “electronic structure of atoms”.  What 
does this mean?  The key concept is that the electrons within atoms can only possess specific 
energies.  You may have already heard about electron “shells” or perhaps even “orbitals” as part 
of your pre-Macalester chemistry experiences.  The “shell” or “orbital” designation for an 
electron provides some information about its energy.  The objective of this Excel activity is to 
introduce you to some key ideas regarding possible energies of electrons in the hydrogen atom.  
Your instructor will elaborate on many of these ideas in class during the next week. 
 
When hydrogen molecules are subjected to a high voltage, the single bond breaks and hydrogen 
atoms are produced.  Due to the high voltage, it is relatively easy for the single electron in each 
hydrogen atom to become “excited”.  An “excited” electron is one that possesses a higher energy 
than the minimum for an electron in hydrogen.  We say that an electron in hydrogen at the 
minimum energy possible is in the ground state.  The ground state energy level is labeled n = 1.  
An excited electron could be described as occupying an energy level with an n value from 2 to 
any integer value approaching infinity.  Each level corresponds to a specific energy. 
 
An electron is most stable in the ground state (n = 1) and there is a natural tendency for excited 
electrons (n = 2 or greater) to release energy to ultimately arrive in the ground state.  The 
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released energy can be in the form of x-ray, ultraviolet, infrared, or visible radiation depending 
on the difference in energy between the levels occupied by the electron before and after the 
change.  In this way, if we can measure the energy released when an electron moves from one 
level to another, we simultaneously measure the energy difference between the levels occupied 
by the electron.  This concept of energy levels and released energy is portrayed in Figure 1.  
Please note that this figure is completely generic and doesn’t apply to the hydrogen atom. 
 

1

2

3

4

e-
-6 aJ

-7 aJ

-8 aJ

-4 aJ

1

2

3

4

-6 aJ

-7 aJ

-8 aJ

-4 aJ

1

2

3

4

-6 aJ

-7 aJ

-8 aJ

-4 aJ
e-

e-

Excited Electron moves 
from n = 4 level to n =3 
levelE

The energy released:
-4 aJ - (-6 aJ) = 2 aJ

Excited Electron moves 
from n = 3 level to n = 2 
level

The energy released: 
-6 aJ - (-7 aJ) = 1 aJ

Figure 1:  The Relationship between Released Energy and the Difference in Energy 
Between Levels  

 
In this representation, the excited electron starts in the n = 4 level with an energy of –4 aJ.  The 
Joule (J) is the SI unit for energy and 1 aJ = 10-18 J.  The electron moves from the n = 4 level to 
the n = 3 level and simultaneously lowers its energy to –6 aJ.  The difference in energy between 
the two levels (2 aJ) is released (or emitted).  In the next step, the electron jumps to the n = 2 
level and emits 1 aJ of energy.  Note that excited electrons aren’t limited to jumping between 
adjacent levels (as depicted in the figure).  It would certainly be possible for an electron to jump 
directly from n = 4 to n = 1.  In this case, 4 aJ would be emitted. 
 
The main point is that a measurement of the emitted energy provides information about the 
separation between the energy levels.  As mentioned earlier, the energy released when an excited 
electron drops to a lower level is emitted as either x-ray, ultraviolet, infrared, or visible radiation. 

 
The next part of this experiment will provide you a glimpse of excited hydrogen atoms and the 
emitted energy (as a result of placing hydrogen molecules under a high voltage).  You will find 
that the overall color of the excited hydrogen atoms is pink; this indicates the some visible 
radiation is emitted as excited electrons jump to lower levels.  We can use a diffraction grating to 
separate the pink color into its component colors- each component color will correspond to the 
energy difference between two hydrogen atom energy levels. 
 
Go to OR344 to examine these colors (often referred to as the atomic spectrum of 
hydrogen)!  Notify your lab assistant or lab instructor when you are ready to look at this 
spectrum.  Take care when moving near the hydrogen sample since it is under a very high 
voltage. 
 
If all went well, the pink color of the excited hydrogen atoms should have separated into four 
visible colors upon employment of the diffraction grating:  violet, blue, blue-green, and red.  To 
find the energy level separations that correspond to these colors, we must convert these colors to 
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energies.  We’ll use Excel and material from Chapter 7 of Silberberg to conduct these 
calculations.  These topics will be discussed in class very soon so don’t worry if some of the 
steps seem nebulous at the moment. 
 

• You should be on “Sheet 2” of your workbook, which should be blank. 
   
• Enter “Emitted Color” in A1, “Violet” in A2, “Blue” in A3, “Blue-green” in A4, 

and “Red” in A5.   
 

• Enter “Wavelength (nm)” in B1.   
 

• Format the headings and other text with the same styles used on the first sheet of 
your workbook. 

 
• After formatting, the “Wavelength (nm)” entry in B1 will be a little too wide to fit 

in its cell.  To fix this, automatically increase the width of column B in your 
spreadsheet by positioning your pointer mid-way between the B and C cell 
column headings at the top of the sheet.   It should turn into a vertical line with 
arrows pointing left and right out of it.  Double-click to fix the column width. 

 
One fascinating property of electromagnetic radiation is that it simultaneously exhibits properties 
of particles and of waves.  You may have heard of the “wave-particle duality” of light before; 
this topic is also discussed in Chapter 7 of Silberberg.  Since light can be described by wave 
properties, each color of the visible spectrum has a unique wavelength.  A common unit for 
wavelength, the distance between any point on a wave and the corresponding point on the next 
wave, is nanometers.  The visible wavelengths of the hydrogen spectrum are 410.1 (violet), 
434.1 (blue-violet), 486.1 (blue-green), and 656.3 (red) nanometers.   
 

• Enter these data appropriately in column B. 
 
• Format the numbers as necessary to display the proper number of significant 

digits. 
 
It turns out that all of the emitted visible radiation from excited hydrogen atoms is the result of 
electrons moving from higher levels to the n = 2 level.  Transitions to the ground (n = 1) level 
emit ultraviolet light that our eyes cannot detect.  If you have ever tanned at a tanning salon, you 
have been bombarded with ultraviolet radiation from excited mercury (Hg) atoms that were 
similarly excited at high voltage. 
 
Let’s enter the initial and final values of n into our spreadsheet for these four colors.   
 

• Enter and format the headings “Initial n” into C1 and “Final n” into D1.  
  
• All four “Final n” values are 2, while the “Initial n” values range from n = 6 (the 

starting level for the electron that emitted the violet light) with decreasing integer 
values to n = 3 (the starting level for the electron that emitted the red light). 

 
• Format the numbers appropriately.  Since these numbers are exact, select “single 

underline” from the Format:Font menu to indicate they have no uncertainty. 
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The next step is to convert our wavelength values into their associated energies.  It is useful to 
convert our nanometer wavelengths to meters before conducting this calculation.  Let’s use Excel 
to our full advantage to accomplish this objective.   
 

• Enter and format “1 nanometer =” in A7, “1e-9” in B7, and “meters” in C7.  One 
nanometer is exactly 1 × 10-9 meters (by definition), so format it as scientific, with 
zero decimal places, and underline it (to indicate that it is exact). 

 
Remember that 1e-9 is how one enters 1 * 10-9 in an Excel spreadsheet.  Now we can use this 
conversion factor to convert our data in column B to meters. 
 

• Enter and format the “Wavelength (m)” heading in E1.  
  
• In E2 type “=B2*$B$7” and enter.   

 
• Click and drag down from this cell to convert the other wavelengths with the 

“locked” conversion factor.  The wavelengths should be in scientific notation with 
the proper number of significant figures (4, because the nanometer wavelength 
data has 4 and the conversion factor being used is exact).   

 
• Format these numbers if necessary (“Cells” from “Format” menu and then the 

“number” tab.  “Scientific” is one of the number formatting options). 
 
The wavelength of radiation is related to its frequency (the number of cycles the wave undergoes 
per second), by the following equation where the speed of light is 3.00 * 108 meters/second. 

Frequency (1/s) =
Speed of light (m/s)

Wavelength (m)

 
 

• Enter and format “Speed of Light =” in A8, “3e8” in B8, and “meters/second” in 
C8 to establish the conversion factor.  This constant is reliable to 3 significant 
figures, so format it accordingly. 

 
• Enter and format the “Frequency (1/s)” heading in F1. 

 
• Type “=$B$8/E2” and enter.   

 
• Click and drag to calculate the other three frequencies.   

 
• Format these data if necessary so that the correct number of significant figures (3, 

because we are now limited by the 3 significant figures in our speed of light 
constant!) and scientific notation are displayed. 

 
The frequency of radiation and energy are related by Planck’s Law: 
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E  =  hυ

energy of photon Planck's constant

frequency of radiation

 
 
A “photon” is a “packet” of energy.  The wave-particle duality of light means that the blue 
radiation emitted by excited hydrogen atoms can be simultaneously considered as waves with 
434.1 nm wavelength or as a stream of photons, each containing the same amount of energy, 
with the amount given by Planck’s Law. 
 
Let’s calculate the photon energies that correspond to the colors that you observed!  We first 
need to add Planck’s Constant, 6.626 * 10-34 Js, to our spreadsheet as a constant.   
 

• Enter and format “Planck’s Const. =” in A9, “6.626e-34” in B9, and “Js” in C9.  
  
• Format the number/text as needed. 

 
• Enter and format “Photon Energy (J)” in A11.  This entry will be too wide for its 

column, but you know how to fix that!  Apply the same fix you did after entering 
the Wavelength heading at the top of column B. 

 
• Type “=$B$9*F2” in A12 and hit return.   

 
• Click and drag to calculate the other photon energies.   

 
• Format the numbers so that they are displayed in scientific notation and with an 

appropriate number of significant digits.   
 
Note that these photon energies correspond exactly to the energy differences between the 
energy levels labeled by the numbers in columns C and D. 
 
A famous equation was developed to calculate the energy difference between any two energy 
levels in a hydrogen atom if the two values of n are known: 
 

∆E = RH
n2

final n2
initial

1 1

energy difference between levels
(energy of emitted photon)

"Rydberg Constant"
This is always "2"
for our data

The colors that we observed 
were due to electrons that 
started in levels n = 6, 5, 4, 3
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We can find the Rydberg Constant by manipulating this equation and then graphing our data 
appropriately.  The following equation is another form of the one shown above: 
 

∆E  = -RH
n2

finaln2
initial

11

energy difference between levels
"Rydberg Constant"

RH

y m x

b

(a constant since nfinal always equals 2)
 

As indicated above, a plot of the energy difference between levels versus 1/n2
initial should provide 

a linear relationship.  Furthermore, the slope of this line (m) will be equal to –RH (Rydberg 
Constant). 
 
Let’s set up our data for graphing:  
 

• Enter and format “1/n2
initial” in B11.  You can format particular portions of a text 

entry by highlighting just them (the “2” here, for example) and then choosing 
“Cells” from the “Format” menu.  The formatting you select (e.g. checking the 
box for Superscript effect) will be applied to only the selected text. 

   
• The superscript and subscript options are available in the “Format cells” window 

under “Font”. 
 

• Enter “=1/(C2^2)” in B12.   
 

• Click and drag to calculate the other three values.  These results are exact, so they 
should be formatted with a single underline to indicate that this is the case. 

 
• Enter and format “DE (Joules)” in C11.  Convert the capital letter D at the start of 

this heading to a ∆ by converting (only) the “D” to the “Symbol” font in the 
format cells window (font tab).  The final heading should be “∆E (Joules).” 

 
• Enter “=A12” in C12 and then click and drag to copy the appropriate energies into 

the three cells below.   
 
Now we have our four data points to graph!  Please note that Excel automatically assigns the left 
column of data as the x variable and the right column as the y variable. 
 

• Highlight the two columns of data (without the headings). 
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• Click on the Chart Wizard icon.   
 

• Select “XY(Scatter)” and its Chart sub-type shown at the top.  It is very 
important to use the Scatter chart type in plotting scientific data.  Other 
chart formats treat x-axis data as text, not numeric data: a BIG problem! 

 
• Select “Next >” twice.   

 
• In the “Chart Wizard – Step 3 of 4 – Chart Options” window add an appropriate 

title and axis labels to your graph.  Select the “Titles” tab and then: 
⋅ Label the graph “Atomic Spectrum of Hydrogen” in the Chart Title window. 
⋅ Label the x-axis “1/n2

initial”. 
⋅ Label the y-axis “Energy Difference Between Levels (J)” 

 
• Under “Gridlines,” examine the various options.  For this graph it is probably best 

to deselect all gridlines for best appearance.   
 
• Select the “Legend” tab and deselect “Show Legend”.   

 
• Click on “Next” and then “Finish”.  Your graph should appear.   

 
• Move the graph to the left edge of the spreadsheet, just below your data.  Resize 

the graph with the mouse if necessary. 
 

• Excel automatically formats your chart, but it doesn’t always do a good job, 
scientifically speaking (just as it fails with respect to significant figures)!  To do a 
better job, double-click on the line (not the numbers) of the y-axis.  This should 
bring up a “format axis” window.  Click on the Scale tab, then put “2.5e-19” into 
the minimum box.  (This is a much more appropriate value than the zero that 
Excel has chosen, because it makes much better use of the space inside the chart: 
since the smallest energy is actually 3.0 × 10-19 J, a y-axis minimum of zero 
means that over half the chart will be devoid of any data!) 

 
Trendlines 
Your four data points should appear to indicate a line.  We can use Excel to determine the 
equation of the best linear fit to the data, and to guage how well the data fit this linear 
relationship.  Excel can calculate the line (often called a trendline) that best fits the points. 

 
• Click on one of the four data points.  All four of the points should become 

highlighted in yellow. 
 

• From the “Chart” menu, select “Add Trendline”.  Under “Type” choose “Linear”. 
 

• Under “Options”, select “Display equation on chart” and “Display R-squared 
value on chart” before clicking “OK”. 

 
• If the trendline equation overlaps on the graph, drag the box to a better location on 

the chart. 
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The line equation provided (in y = mx + b form) is the one that best fits the data in the graph.  An 
important issue is how many significant figures should be included in the equation of the line.  
Excel is clueless about this, so you have to do the thinking!  Since the slope of the line is the rise 
over the run, or the change in y over the change in x, application of significant figures rules tells 
us that the slope should have as many significant digits as do the x and y data, whichever has 
fewer if they differ.  In this case the 1/n2 data is exact (it has an unlimited number of significant 
digits, or no uncertainty), while the ∆E data has three, so the slope should be reported with three 
significant figures.  (With large amounts of very accurate data, slopes can actually be appreciably 
more reliable than this estimation method suggests.)  To make that change, click on the equation 
of the line and then select “Selected Data Labels…” from the “Format” menu.  Change the 
numeric format to scientific, with two decimal places.  The slope of your graph should equal –
RH, the Rydberg Constant (2.18 * 10-18 J). 
 
The R2 value measures the strength of the linear association between the variables, and is 
sometimes called the correlation coefficient.  It can range from 0 to 1.  An R2 value of exactly 1 
indicates a perfect linear relationship, and a perfect fit - all points lie exactly on the trendline.  
That’s very rare in science, but it can happen in cases (such as this one) where the data and the 
theory are both very good.  More often, R2 values of less than one are obtained, indicating that 
the data points don’t fall exactly on the line.  R2 gets smaller as the discrepancies grow larger, 
and determining the reason for such discrepancies is a key challenge in science.  There are two 
types of deviation from a curve fit, and it is important to understand the difference: 

a) Random deviations from linearity generally reflect shortcomings in one’s equipment 
and methodologies, rather than an inadequacy in the theory.  These are most common. 

b) Systematic deviations from linearity can be caused by calculation errors, systematic 
errors in the laboratory, or by a failure of the theory that is being applied.  If you see a 
systematic error, be careful!  Try to ensure that it isn’t the result of a calculation error. 

 
It is important to realize that an R2 value can’t really tell you if you have a “good fit!”  It 
can tell you if you have a perfect fit, but that is very rare indeed.  When R2 < 0.95 or so, you 
really have to look at your data and determine if the deviation from linearity is random or 
systematic.  If the deviation is random, an R2 value of 0.95 is probably a very good indicator 
of the quality of your data and the applicability of your theory.  If the error is systematic, 
on the other hand, you may not have a “good fit!”  R2 assumes your error is random.  R2 
can be used to compare the relative quality of two different linear fits (two different 
theories), but one R2 value winning out over another does not preclude the possibility that 
yet another fit (another theory) fits the data better still, and is actually valid. 
 
Complete any necessary formatting to make your spreadsheet look as presentable as possible.  
Print your entire spreadsheet to include with your report.  Name this sheet “Atomic Spectrum” 
and click on the Sheet 3 tab to bring up a new sheet for the following exercises.  Since there are 
four more exercises, you will need three more sheets.  To get them, click on the Sheet 3 tab, then 
drag slightly to the right with the option key depressed.  (This copies the selected sheet.)  Do this 
twice more, so that you have a total of six tabs, and thus six sheets. 
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Additional Excel Exercises 
Use Excel to complete these four additional exercises.  Your report for this experiment should 
consist of printed spreadsheets for the chromium isotopes, atomic spectrum of hydrogen, and the 
following four problems.  You should put each one of these exercises onto a separate sheet, 
naming each tab appropriately.  Take care to generate spreadsheets that are easy to read, 
with formatting similar to that presented in this activity (i.e., headings should be 
differentiated from data in some way, data should be clearly presented in tabular form, 
conversion factors should be listed separately with labels and units, and conversion factors 
should be properly “locked” during calculations).  These will be the spreadsheet expectations 
whenever Excel is required in Chemistry 111/112. 
 
#1.  One reaction that you will carry out this semester is that of sulfuric acid and barium nitrate.  
The result is the precipitation of barium sulfate. 

H2SO4(aq)    +    Ba(NO3)2(aq) 2  HNO3(aq)    +    BaSO4(s)

 
A student mixed aqueous solutions containing 1.1 moles of sulfuric acid and 2.0 moles of barium 
nitrate.  She subsequently collected the barium sulfate precipitate via filtration and massed the 
solid.  The student repeated this experiment seven times and obtained the following masses of 
BaSO4(s) (Experiment #, BaSO4(s) (g)). 
 
Exp. 1, 235.1 Exp. 2, 220.4 Exp. 3, 255.6 Exp. 4, 256.5 Exp. 5, 214.0 Exp. 6, 218.5 Exp. 7, 
253.5 
 
Organize these data in a spreadsheet and calculate the average, average deviation and standard 
deviation of the masses.  These functions are listed under “Statistical” in the Function Wizard. 
 
The theoretical yield of barium sulfate is 257 grams for these reactions.  Use Excel to calculate 
the Percent Yield in the column adjacent to the masses.  Use 257 grams as a “locked” constant 
for these calculations.  Percent Yield = (mass obtained/theoretical yield), formatted with the 
“percentage” number format and the correct number of significant figures. 
 
#2.  One topic of interest in Chemistry 112 is chemical kinetics, the speed of chemical reactions.  
The chemical kinetics of a reaction were studied by measuring how the concentration of its 
reactant changed with time.  A chemist collected the following data: 
 
 

Time (seconds) Reactant Concentration (M) 
0 5.00 
2 4.96 
5 4.85 
10 4.70 
15 4.50 
20 4.38 
30 4.01 
40 3.78 
60 3.08 
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Display these data in a spreadsheet with appropriate column headings.  Use the Chart Wizard 
to create a graph that appropriately and accurately communicates the decrease in 
concentration of the reactant with time.  Provide your graph with appropriate titles and axis 
labels.  Put time on the x-axis and reactant concentration on the y-axis.  Your chart should 
include a trendline, with its equation and R2 value added to the chart by Excel (not by hand!). 
 
Use the trendline equation to predict the reactant concentration at 80 seconds.  Show all of your 
work on the spreadsheet and do not use a calculator, except perhaps to check your work.  Make 
sure that your result makes sense in light of the data given above.  (For example, 4.05 M would 
not make sense…nor would a negative concentration, like, say, -12.16 M!) 
 
#3.  In one Chemistry 111 experiment, the moles of hydrogen gas produced are measured and 
correlated with the percent aluminum in a metal sample.  Before conducting this experiment, it is 
valuable to determine the relationship between these variables.  A series of standards containing 
accurate and precise amounts of zinc were purchased and the moles of hydrogen produced from 
each were measured. 
 

Percent Zn in Standard Moles of Hydrogen Produced 
90.0 0.05148 
85.0 0.05020 
80.0 0.04715 
75.0 0.04552 
70.0 0.04370 
65.0 0.04100 

 
Use this data to generate an XY Scatter plot with appropriate title, axis labels, trendline, equation 
on chart and R2 value.  One key decision is which column should be x-axis data and which set 
should be y-axis data.  Should the graph plot “Percent Zn in Standard” (y) versus “Moles of 
Hydrogen Produced” (x) or “Moles of Hydrogen Produced” (y) versus “Percent Zn in Standard” 
(x)?  The y data are referred to as the dependent variables while the x data are the independent 
variables.  The dependent variable is determined experimentally.  The experimentalist establishes 
the independent variable as part of the experiment design.  Another important issue is how many 
significant figures should be included in the equation of the line.  Remember, Excel is clueless 
about this, so you have to do the thinking and format the equation of the line appropriately! 
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#4.  It is important to determine the mathematical relationship between sets of experimental data 
in many chemical studies.  In the study of chemical kinetics, a common strategy for learning 
about how a reaction works is to measure the concentration of a reactant with respect to time.  A 
variety of possible linear relationships between concentration and time are subsequently 
examined via the construction of graphs.  The graph that provides the best linear fit to the data 
(gauged by the lack of a systematic deviation from the trendline, NOT from the R2 value) 
communicates the “order” of the reaction with respect to the reactant concentration. 
 
Although we won’t derive these key relationships until Chemistry 112, the following graphs can 
be used to decide between zero, first, and second order reaction kinetics with respect to the 
reactant concentration measured: 
 

Order for 
[Reactant] 

Graph that Exhibits  
Linear Relationship 

Consequence of the Order on the Reaction Rate 

Zero [Reactant] vs. time The rate of the reaction is independent of the 
concentration of the reactant. 

First  ln[Reactant] vs. time The rate of the reaction is directly proportional to 
the concentration of reactant.  If the concentration of 
reactant is doubled, the rate doubles. 

Second 1/[Reactant] vs. time If the concentration of reactant is doubled, the rate 
increases by a factor of four.  

 
A chemistry student collected the following kinetics data.  Use Excel’s Function and Chart 
Wizards to determine the order of this reaction with respect to the reactant.  Check for zero, 
first, and second order possibilities.  All graphed data should be calculated with Excel and 
organized on the spreadsheet (no calculators allowed!).  All three graphs should include 
appropriate titles, axis labels, trendlines, line equations, and R2 values.  In this scenario, the error 
in the data is random (and small), and so the largest R2 value will indicate which chart reflects 
the correct reaction order.  Be sure to explicitly state what you conclude the reaction order is! 
 
Time (minutes) Reactant Concentration,  

[Reactant] (M) 
0 0.0165 
10 0.0124 
20 0.0093 
30 0.0071 
40 0.0053 
50 0.0039 
60 0.0029 
 
 


